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Microsoft Dynamics GP Features

E

Microsoft Proprietary and Confidential Information

This course/module was created for Partners and Customers.

It will take approximately 120 minutes to train the features in Microsoft Dynamics GP.

The features for Microsoft Dynamics GP are built around:
Ease of Use - Customer Requests - Extend Functionality

After this course/module you will be able to:

Understand the Microsoft Dynamics GP Features.
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Microsoft Dynamics GP Lifecycle

® The time to complete this lesson, including exercises, is 30 minutes.

After this lesson you will be able to:

@ e Understand the Lifecycle and what is Modern Lifecycle

Lifecyle for Microsoft Dynamics GP

Understand the Lifecycle Policies for Dynamics GP:

Software lifecycle policy - Dynamics GP | Microsoft Docs

Microsoft is fully committed to supporting our Dynamics GP customers for years to come

The exciting future of Microsoft Dynamics GP - Lifecycle Update

What Does Modern Lifecycle mean for Dynamics GP?

Dynamics GP versions governed by Fixed and Modern Lifecycle

ycle

Fixed Lifec

Modern

L] L L L L ® L L L ® L
2m8 2019 2020 2021 2022 2023 2024 2025 2026 2027 @ 2028
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https://docs.microsoft.com/en-us/dynamics-gp/terms/lifecycle
https://community.dynamics.com/blogs/post/?postid=e58993d7-1171-4d22-b835-1605b5ccd5bb
https://community.dynamics.com/gp/b/dynamicsgp/posts/the-exciting-future-of-microsoft-dynamics-gp---lifecycle-update
https://community.dynamics.com/gp/b/dynamicsgp/posts/what-does-modern-lifecycle-mean-for-microsoft-dynamics-gp
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System Requirements Updates

The following changes have been made to the Dynamics GP System Requirements for 18.6 release.

Here is a summary of the supported SQL versions based on Microsoft Dynamics GP version.
-GP 2013 supports SQL 2014, 2012 and 2008

-GP 2015 supports SQL 2014 and 2012

-GP 2016 supports SQL 2016, 2014 and 2012

-GP 2018 supports SQL 2017, 2016 and 2014

-GP 18.2 and later supports SQL 2019 plus SQL 2017, 2016 and 2014

-GP 18.5 &18.6 supports SQL 2022, 2019, 2017 and 2016 (SQL 2014 dropped)

Microsoft Dynamics GP System Requirements

Upgrading to Microsoft Dynamics GP 18.6

Upgrade Hot Topic

The only supported upgrade path to the current release is from the release 1 year back from current in
accordance with the Modern Lifecycle noted above.

Microsoft Dynamics GP 2023 Upgrade Blog Series

® Note: As an example of a supported (tested by Microsoft) upgrade path to 18.6 (October 2023
Release) or 2023 Year-End would be from GP 18.4.1361 or later.
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https://docs.microsoft.com/en-us/dynamics/s-e/gp/mdgp2018_system_requirements
https://docs.microsoft.com/en-us/dynamics/s-e/gp/hot_topic_mdgpupgrade_415
https://docs.microsoft.com/en-us/dynamics-gp/terms/lifecycle
https://community.dynamics.com/blogs/post/?postid=3c898ac9-c44d-ee11-a81c-6045bd7e366e
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Application Features

® The time to complete this lesson, including exercises, is 30 minutes.

@ After this lesson you will be able to:

e Familiarize yourself with the features related to Application Modules.

Financial Summary Inquiry Redisplay

If transactions are posted while Financial Summary Inquiry is open (Select Inquiry, choose Financial, click
Summary), you can now redisplay instead of having to close the window. How simple is that right?

With Microsoft Dynamics GP 18.6, a redisplay button is added to the Financial Summary Inquiry Window
(Similar to Detail Inquiry window). When the user clicks the redisplay, the system will refresh the data for
the account entered, display the same account and year information and redisplay the refreshed data.
That way, if the summary inquiry window is open with an account selected, if the user posts a transaction,
they can redisplay to see the updated posted information.

P summary Inquiry - TWOOS (sa) = m] X

DT pEw i@

Clear |REGERIEY = View  File Print  Tools | Help Add

A ¥ MNote
Actions View File = Help

Acoount 000-1100-00 p-’
Description Cash - Operating Account Year 2027 w
Period Diebit Credit Met Change Period Balance
Beginning B alance $0.00 $0.00 $0.00 $0.00
Period 1 $0.00 $0.00 $0.00 $0.00
Period 2 $56,583.42 $2.934.59 $53.588.83 $53.588.83
Period 3 $33.422.79 $96.695.26 [$63.272.47) ($9,683.64)
Period 4 $185,709.22 $12.945.09 $172,764.13 $163.080.49
Period 5 £0.00 $50.00 [$50.00) $163.030.49
Period B $0.00 $0.00 $0.00 $163.030.49
Period 7 $0.00 $0.00 $0.00 $163,030.49
Period & $0.00 $0.00 $0.00 $163,030.49
Period 9 $0.00 $0.00 $0.00 $163,030.49
Period 10 $0.00 $0.00 $0.00 $163,030.49
Period 11 $0.00 $0.00 $0.00 $163,030.49
Period 12 $0.00 $0.00 $0.00 $163,030.49

Tatalz $275,715.43 $112.684.94 $163.030.49 $163.030.49

Cumency

Microsoft Proprietary and Confidential Information 4
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Reverse Fiscal year end close by Company

When the Reverse Fiscal year feature was added, it required all users to be out of ALL Dynamics GP

companies. Now with the release if 18.6, you only need all users to be out of company you are in to
reverse Fiscal Year End Close for that company only.

You no longer need to have all users logged out of all companies. What a time saver and allows your
users to keep processing in other companies.

Example of the error message you would receive prior to the 18.6 release.

You can click Tools, choose Routines, click Financial and then select Year-End Closing.

m Year-End Closing - BANK (=a) —

JI0 3=

Clear File | Toocls Help Add

d ¥  Mote
Actio... | File v Help
Retained Eamings Accownt 1 - - B
Sfanting Jownal £ofry 1 Tear 2022

- Y'ou cannot reverse the histanical year because other ugers are
\‘\1’) logged in to the system.
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https://community.dynamics.com/blogs/post/?postid=b4dc8f8a-27b6-4ad0-8d45-ac35066b4c9b
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Customer statements display open items

With the release of 18.6, an option was added for Customer statements to display or remove Fully Applied
Transactions.

This will remove any payments, credits, debits, invoices that have been fully applied.

Prior to 18.6, if you use the option for ‘exclude fully paid PAYMENTS', then it only drops off the payment,

but the invoice is still listed (but with a zero balance). The RM statement pulls ALL documents from the
RM20101 OPEN trx table.

Prior to 18.6

| Document No. | Date |Code | Description |Amount | Balance |
PYMNTO00000710810 412/2027 PMT $0.00
SALES00000001409 4n2/2027 SLS $100.00 $100.00
PYMNTO00000710810 412/2027 PMT Applied: SALES00000001409 ($100.00) $0.00
SALES00000001410 412/2027 SLS $50.00 $50.00

What we heard from customers is that there is a need to exclude fully paid DOCUMENTS', where it would
exclude all documents with a CURTRXM = 0.00 in the RM20101 table.

From the Sales area page, under Routines, choose Statements
m Print Recevables Statements - TWOUO5 (sa)

) = O X
. = P =
= el || |'0'|
H 9 ?( =7 = 7w
Save Clear Delete E-mail File Print  Tools | Help Add
- T  Mote

Actions File = Help
Statement 1D ELANE FORM p [ Description Blank Form
Last Printed Frirt: © Statements () aslignment Form

E mail Option [C] Print Remaining Statements
Address 1D 5| DatetaPrint  |Enter Date | 2n8s2027
Form: On Blank Paper ~ | Summarize ta Enter D ate ~ H
Customers: by Cugtomer ID s | Cut-0ff Date Enter Date v =
Documents: by Document Number [ Reduce Oldest &ging Period Amounts by Unapplied Credit &mounts
Frint For: Inciude Type: Frirt;
Show Applied Payments O &l B Credit Limits B Payment Tems
I E () Open Item B Finance Charge B tessages
| () Balance Forward Individual Child Statements
Ranges: by Custamer (D v|° &l ) Fram:
To:
Riestrictions:
Insert 33 by Type from First to S
Remoye Messages
Destination
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If you choose the Exclude Fully Applied Payments option from the above window, many lines will be
removed from the statement.

STATEMENT Date: | 4/30/2027 |
Fabrikam, Inc. Account: | ADAMPARK0001 ]
Amount Paid:

ADAM PARK RESORT Credit Limit: $40,000.00

ROBERTA MASOURAS Payment Terms: Net 30

SUITE 9876 Finance Charge APR: 18.00%

321 CHESTNUT DRIVE Deposits Received: $0.00

INDIANAPOLIS IN  46206-1391

"Please retum thiz portion with your payment®

Document No. Date Code | Description Amount Balance

RMAD03001 8/31/2027 SLS RMA003001 $933.58 $933.58
SALES00000001006 3/15/2027 SLs $153.01 $1,086.59
SLS13014 1/23/2024 SLS $8.500.00 $9,586 59
5L513015 1/29/2024 SLS 5547019 $15.031.78
SLS3004 11/23/2023 SLSs $2,535.76 $17.42312
STDINV2225 4/12/2027 SLS STDINV2225 $96.25 $17.519.37
STDINV2229 4/12/2027 SLS STDINV2229 $2,567.95 520,087 32
STDINV2250 412/2027 SLS STDINV2250 $31.95 $20,119.27

The most common request we receive from our customers regarding statements is to only show open
items, like the example above. Prior to the 18.6 release, the only solution is to use the Paid Transaction
Removal tool.

With this new feature, it is still important to use the Paid Transaction Removal routinely, you may be able
to get away with not running it as frequently as you used to on prior Dynamics GP versions.

Microsoft Proprietary and Confidential Information
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Email/Reprint Vendor Remittance with
message fields

Many customers modify the Message setup specific to information they want the vendor to understand
with the email. When you email or reprint the vendor remittances, the customized fields you added from

email message setup are not included.

Go to Purchasing > Inquiry > Transaction by Vendor > Select Vendor ID >Select the Payment > click on
the blue Document Number> Click on Re-create Check Stub button > send re-print EFT remittance email.

With the release of 18.6 the customized fields that you added and printed on the original form, will now
also print or be included when you email or reprint the remittance from the Inquiry window.

Pl Message Setup - TWO (sa — O ot
=D X 0y @]

Save Clear Delete Copy File | Tools Help Add @ Debug

v T  Mote it
Actions File v Help Debug

Meszage ID REMITTARCE p

Dezcription

Message Type Standard w

Series Purchaszing w

Doc. Type Wendaor Remittance e

Subject

Biody I Document Lines I W alidate
Hello, ~

Attached iz pour %D ocument Humberi | remittance in the amount of 1% Check Total%}

Should pou have any questions, please contac the AP department at {32Address 1%}

Microsoft Proprietary and Confidential Information
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ALL Payables 1099 forms print with LINES.

With the 18.5 release, we were really excited to have the feature which allowed you to print a 1099-NEC
form with boxes/lines on blank paper. (Similar to what we do with Payroll W-2's)

With this positive feedback from customers with the release of 18.6, all the Payables 1099 forms will now
print on blank paper, Miscellaneous, Dividend and Interest.

The new report writer forms will print on 8.5 X 11 blank paper and prints one 109 per page. This will be a
nice feature to print your forms to screen and verify 1099 information. It also could be used as the form

that is delivered to the vendor.

Microsoft Dynamics GP does not print the 3-part 1099-NEC form with boxes by the IRS (About Form
1099-NEC, Nonemployee Compensation | Internal Revenue Service (irs.gov) ). Usually, customers will

submit the forms electronically to the IRS vs a printed copy.

To print the 1099 forms with boxes follow these instructions:

Go to Purchasing >> Routines >> Print 1099

1099 Year: select the current year

Form Type: select "One Wide with Box"

Add the remaining information in this window and click the "Print Forms File"

B Print 1009 - TWOO5 (sa) - X

Clear  File Print Print Tools ~Help Add
¥ Forms ¥ MNote

Actio... File “ Help

Lompany Fabrikam, Inc.

Adidexs 1D Frimary p

Address 4277 west Oak Parkway

City Chicago

State IL

ZIF Cods EUE01-4277

Fhone [312) 436-2671 Ext 0000

Email Address

Paper's Federal D Number

1099 ear 2027
1059 Type Fom e [ RESRGRRES |
Wendor

Vendor D v @&l O From
To

PAYER'S rame. sioat a000ss. Cify or bown, S5 o province., country, ZF
or forsign postal code, and talegnone ro

Fabrikam, Inc.
4277 West Oak Parkway

Chicago IL €0€01-4277
(312} 43€-2€71 Ext. 0000

[JCORRECTED (if checked)

1 Rerts OMB Na. 15450115
s Farm 1099-MISC Miscellaneous
Z oy S — Information

For caenckr yor

2027
Ot (e 4 Fadarsl insome tax withhaid

0.88 Copy B

FAYERE TH RECFENTE TH Fishing ot process: EMadcal and hith cae For Recipient
pamarts
3 ]
RECEENTS rave 7Fan & Scbsttte oavments Inlis
2 Travel Company = of dvigends ot
3 ThE s Impurert 2
s ey,
Siract sess frcluding 20t ra | 10 Goss omceeds pudtoan | Amhed ot RSy o
Sweat adcress fncluding a0t i il b 3 1 e
regience ey o o
- 1 ‘sencin mey be impoed on
Jou 942 ncome = e
= " Saction 1003 dafamds nd e 23 i e
ity o bown, 363t O prow e, oy, and 28 o toreign postal code TIFsnpunaetionesa |12 Sechon 4053 ceteria e 1 e e
3 ]
13FATGAfling | 14 Excess onicen pamchite | 15 Morculifed cetemad
Renuiremant Paymarts compersaions
O | s
“Azcount e (See IS mucions] 16 Stata b withaia 17 SiataFayers st ro 18 Shata Incoma
3
3

som A099-MISC  men 1200

osse for our recns|

Note: With the 2022 Year-End form changes from IRS the "For calendar year" field is now blank.
In prior years it was populated/printed with a year. On this new form, the year is printed from
the "1099 Year" field in the above Print 1099 window.

®
o
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https://community.dynamics.com/blogs/post/?postid=ce2df310-546b-483e-b403-6827aff2f00f
https://community.dynamics.com/blogs/post/?postid=ce2df310-546b-483e-b403-6827aff2f00f
https://www.irs.gov/forms-pubs/about-form-1099-nec
https://www.irs.gov/forms-pubs/about-form-1099-nec
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Drop Down List Selection for Batch Source
on Navigation Lists.

As we talk about adding to core features and building on existing functionality, our customers stated the
Batch Number and Batch Source added to Navigation lists was a HUGE hit in GP 18.5. They wanted more!

With the release of 18.6, again on the Navigation List as everyone loves them and uses them, we added a
filter on Batch Source (which was there before), but now you can have a drop-down list of all your batch
sources. What users found was it was hard to find the source and type it in exactly correctly, Now we
have the lists added for you for easy access to filter based on it.

c[g_.

= s [ Sales / Invoices 7 Last 90 Daysw @

=] - 5] Payments | “F Include Historic Transacti. >
= Reports | Go T
s {5 Scheduled Payments potis | Bo o

Actions Manage Modify New Restrictions Sales - -

T Receivables Transactions (read only) -

Show result:

# {Where - Batch Source v is ' 2>

% Add Fiter - Dotervon

r Date  Document Tvbe Documen 82:'5:5:’:;?5 ount
] 4/12... Payments PYMNTOO () Transaction Entry 100.00
@] 4/12... Payments PYMNTOO ([ Invoice Entry 375.00
O 4/12.. Payments PYMNTO0 81" el ety 352.94
O 4/12.. Sales/Invoices STDINV22 5 oo con neceipe 128.30
O 4/1 2. Sales / Invoices STDINV22 () Trx Level Transaction Entry 567.95
O 4/12... Sales /Invoices STDINV22 eisure rav... ,139.70
O 4/12.. Sales/Invoices STDINV2225 Adam Park Res... $96.25
{0 4/12.. Sales/Invoices STDINV2226 Baker's Empori..  $5,670.80
‘0 4/12.. Sales/Invoices STDINV2227 Aaron Fitz Elec... $171.10
O 4/2.. Sales/Invoices INVPS1007 West Central D... $99.75
O 4/12.. Sales/Invoices STDINV2237 Office Design S... $74,910....
O 4/12.. Sales/Invoices STDINV2241 Lawrence Tele... $513.50
O 4/12.. Sales/Invoices STDINV2240 Associated Ins... $695.40
O 4/12... Sales /Invoices STDINV2245 Metropolitan F...  $7,051.25
O 4/12.. Sales/Invoices STDINV2246 Communicatio... $31.94
O 4712.. Sales/Invoices STDINVZ2247 Communicatio... $42.59
O 4nm2.. Sales/Invoices STDINV2248 Vision Inc. $73,947....
O 4/12.. Sales/Invoices INVSP1003 Computerized ... $128.35
(m] A Calac / Inunirac CTNDIKN/22AQ Cantnen LA ¢72 047

T All Purchasing Transactions (read only) -
Show results

% Where ~ Batch Source v is ' 2>

e . - O Receivings Transaction Entry
- Add Filter (] Purchasing Inveice Entry
~ Date  Document Tvbe Documen 8 :Et”'”ﬂ""".”.“t'“’” Entry
vided Receivings
0 4/12.. Payment 000000001 () Voided Invoices 6
(] 4/12... Payment 000000001 () Voided Receivings Invoice Matches 0
] 4/12... Payment 00000000t 8 EUfC:TseTerder ptfepa)'ments 0
ayables lransactions
O  4/12.. Standard PO2074 ) Payabies Payments 6
O 4/11...  Invoice 000000001 [ Payables Checks 6
O 4/8/.. Payment 00000000( O Payables Manual Payments 0
O 4/2/..  Invoice 00000000t 81: e Recelings 0
(] 4/2/...  Payment 00000000t [0) Trx Level Returns 1
(] 4/1/...  Blanket PO2071 — TAIravercomp.. T $34,T52....
0 4/1/... Drop-Ship Bla.. P0O2072 ATravel Comp... $39,480....
(] 4/1/...  Shipment RCT1156 Signature Syste...  $1,197.00
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Print and Email Cash Receipts

With the release of 18.5 (2022) we added the functionality to print out a copy of your Customer's Cash
Receipts or email a copy of the Customer's payment with a new word template.

Customers took on to this feature and LOVED it and asked for more!

As a reminder, to activate this feature, go to the Sales Area page, under Setup choose E-mail Settings. In
the Sales E-mail Setup window, you will see the new option for Cash Receipts. You can also use the
Customer Setup button in this window to launch the Customers Navigation List and mass update your
Customers for this feature.

From the Customer Maintenance Card, the email address will pull from the Bill To Address ID. The email
address must be added to the Internet information window on your selected Address ID.

In Dynamics GP 18.5, this feature was missing from the Mass Customer E-mail setting window, but has
now been added. This will allow users to set this up much quicker.

Select Document O ptions

© Send Documents as Attachment () Embed Dacument in Message Body
Attachment O ptions
O Mutiple Attachments per E-mail

[ Set Masimur File Size 0.00 | Megabptes

Send Forms az E-mail

B  Enable Megzage ID Format
B SalesQuote SALES DOCUMENT p
B Sales Order SALES DOCUMENT p
B Sales Fulfilment Order SALES DOCUMENT p
B Sales Invoice SALES DOCUMENT p
B SakesRetun SALES DOCUMENT J5]
B SalesBack Order SALES DOCUMENT p
B  Packing Slip SALES DOCUMENT p
B  Receivables Invoice SALES DOCUMENT p
B  Receivables Retun SALES DOCUMENT p
B  Receivables Debit Mema SALES DOCUMENT p
B Receivables Credit Memo SALES DOCUMENT =
B  FReceivables Finance Charge SALES DOCUMENT =
B  FReceivables Service/Repairs SALES DOCUMENT p
B  FReceivables Waranty SALES DOCUMENT =
Customer Statement SALES DOCUMENT =
h CASH RECEIPT P
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The following areas added the email detail icons to cash receipts entry/inquiry windows.
Transactions--> Sales --> Cash Receipts Entry

Transactions--> Sales --> Cash Receipts Entry --> E-mail Detail Entry

Display the default email address ID on the e-mail detail entry window.

Transactions--> Sales --> Cash Receipts Entry --> E-mail Detail Entry

m Cash Receipts Entry - TWOOS5 (sa) — O X
dy =0 < 3 ) =0 i) g

HoaXk 7 dres @

Save Auto Post Delete Additional File E-mail Print Print Tools Help Add
Apply ~ & ¥  Note

Actions Additional File T Help
Receipt | PYMNT000000000276 LD BatchlD | ABC D>
_ Date 411212027 &

Customer /7 | ASRONFITOOD! g *

Mame Aaron Fitz Electncal Locate Customer By:

Currency D ZU5% PD'} Document ,-‘(-_

© Check () Cash () CretCard | [] EFT

Amount $9.00 Auto Spply To:

heckbaook 1D UPTOWN TRUST P AAROMFIT 00O M ational Account
Lredlt Card 10 | Aoply
Check/Card Number
Comment Diistribustion

You cannot bulk print or email from the Receivables Batches window, only from the All-Sales-Transactions

Navigation List. If you are going to use the Batch Number Filter, best practice would be to use unique
batch IDs or also add a date filter also so that you do not process Payments from previous Batches with
the same ID. In the example below, the All-Sales-Transactions Navigation List is filtered using a
Document Type of Payment and Batch Number so that only Cash Receipts for the specific batch will
appear. | can then mark them all on the list and click Actions then Send in E-mail and then click the Send
button to send all 9 Cash Receipts at once.

= ] 4 Post~ T » 7< Deletev
B4 3 % Print Documents~ [ “Z @
= i _ Send in E-mailv] T ®

Adv. Distribution Modify

- Click below to proceed.
W All Sales Transactions (read only) ~

% Where v~ DocumentType v is v Payments
| it And  ~ BatchNumber ~ contains  ~ TEMPLATE > |

< Add Filter v

T; Date Document Type Document Number Customer Name Amount

] 4/12/2027  Payments PYMNTO00000000274 Aaron Fitz Electrical $1,000.00
] 4/12/2027  Payments PYMNTO00000000275 Aaron Fitz Electrical $100.00
@) 4/12/2027 Payments PYMNTO00000000276 Adam Park Resort $100.00
] 4/12/2027 Payments PYMNTO00000000277 Adam Park Resort $0.00
@) 2 4/12/2027 Payments PYMNTO00000000278 Adam Park Resort $1,000.00
@) 2 4/12/2027 Payments PYMNTO00000000279 Adam Park Resort $0.00
@) 2 4/12/2027 Payments PYMNTO00000000280 Adam Park Resort $100.00
@) 2 4/12/2027 Payments PYMNTO00000000281 Adam Park Resort $10.00
_._ 4/12/2027  Payments PYMNTO00000000283 Berry Medical Center $100.00
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Print Sales Order Processing blank picking

ticket template

Prior to 18.6, the SOP Blank Picking Ticket Bin Sequenced and SOP Blank Picking Ticket Order Entered will
not print the template version when Print Separate Picking Ticket Per Site is checked and sending directly

to the printer. The system will now print the template to the printer. It will print a template for each site

and also a final document that includes all sites combined.

m Sales Document Print Options - T0923 (sa) —

% &

Cancel File Print
-

Actions File

Form to Prnk:
Soat Documents By,

Curency To Pt

Inchude

Quotes
Ordars
Fulilment Orders
() Invoices
Fletutrss
Back Orders
8 Ficking Tickets
8 Packing Slips

Picking Tickets

EH %xu

' @7

Tools Help Add

v

v Help

| Documents

Doc Type/Number

| Functional

Foemnat

Blank Paper

Blank Paper
Blark Paper

B Print Separate Picking Tickat Pes Sie
) Inchide Line Item Comments
Repert Previcushy Printed
() Prink Picking Instiuctions
8 Inchude Kit Components

) BinSequenced

Soet K Componant:
() Print Back Ordered Items
() Prirk Ship To Addiesses with Lines

Report Destination

Repoit Information
e Packing 5ip
Option:

#isk Each Tme

D estination

Repot Type: Template

Destnation

8 Port Document
() Send Documert n E-mal
Documents
Reptint Previousy Printed/Sent

() Inchide K2 Components
() Print Customer ltem
() Prrt Ship To Addiesses with Lines
() Includea Tax Detads

Part Dual Currencies

Line ltem and Summany Taxes

Summary Tases Orly
Packing Sips
8 Piint Sepacaie Packing S Pei Sie]
() Inchade Line ltem Comments
Repart Previously Printed

[ Inchude Drop-ship lems
8 Inchide Kit Companents
() Print Custornes lteen

[ Screen

File Marme:

File Fomnat

‘wornd Documents [*.docx)

Appetid Fieplace
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Set Unit of Measure from the PO Requisition
to the Purchase Order

In the 18.6 release a set up option was added to the Requisition Setup window for the user to choose the
Unit of Measure. A similar feature is available when creating a Purchase order from Sales Order, but
cannot find a similar configuration available for Purchasing module.

On the 18.6 release, when selected, we will use the U of M from the PO Requisition to create the line on
the Purchase Order

When this is not set correctly, the unit cost for the Item is changing during the receiving process which
leads to an effect on our P/L.  The main issue as an example is | have created a Purchase Requisition with
20-CTN. The Vendor accepted to provide the goods in the same UOM. When we convert the UOFM
changes to PKT.

This is an issue during Receiving's as the Vendor may not invoice/receipt in the base UoM ( think of cases
of water - the vendor will send/invoice 1 case, not 24 bottles )

An option was added to Purchasing Setup --> Requisition --> Requisition Purchase for a setting to use
Requisition Item U of M (This is similar functionality to SOP --> Purchase.)

P Requisition Setup - T0923 (sa)  — a X

OX 0 = 1@]
4 k. °
OK Cancel | Additional File Tocls  Help Add

- hd ¥ Note

Actions Additional File - Help

P 5

Requisition D ate: &
Fequisition Line Site [D: Previous Line's Site ID. -~

Wendor S election: Site Primary endor v P purchase Orders Preview - T0923 (sa) - X
Cost Selection: Wendor Last Originating [ryvoice Cost w | —
c3X s @7
Display Requisiiorrs During Entry for: Validate Generate Cancel  File Print | Tools | Help Add
User 1D Fequested By All Requisitions I v ¥ Note
DYMSA (] O Actians File = Help
b ‘ D i;n; %E Vendor | PO Item I Requisitions |
=) GREENLAKOOO1 ltem WIRE-SCO-0001 " [O) Single conductor wire
= New PO-1 Wendorltem | WIRE SINGLE Single Condluctor Wie
= WIRE-SCD-0001 Yendor |D GREENLAKOODT [ Green Lake Wwire Company
REQQO000000000C|  POMumber [ Hew PO P e ship
Oy ToPuchase UM P Sield [ Unit Cost Extended Cost
Renisi s 1000 Yard WAREHOUSE 4048 480
[ Create One Purchase Order Per Ship To Address Requied Dale | 412/2027F @ Minirum Drder 1.00
() Transfer Line Comments Fram Flequisitions Quantity 30.00|  Economic Order 0.00
Base U of M Foot tainum Order 0.00
Caomment D < (] Transfer Comments ta PO
Recent POs far this item
~
User-Defined Vendor PO Number Req Date Unit Cost |
User-Defined 2 User-Defined 2 GREENLAK.. PO2047 1/21/2027 $0.16 f
Line User-Defined 1 Line Defined 1
Line User-Defined 2 Line Defined 2

| Procurement Featured Items
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Format Workflow emails with item decimals

We heard you with over 50+ votes on this feature it was something our customers desperately needed.

Prior to release 18.6, the notification emails from the Workflow feature would default to five decimal
places. For example, this is an assignment email for a Sales Order that has been submitted for approval in
the previous releases:

You have been assigned a task for the New workflow step step in the Sales Transaction workflow for Order ORDST2234.

Task Deadline: 8/15/ 3 4:52:00 PM
Edit or view the document:

Type: Order

Document Number: ORDST2234
Customer:

Document

Document

Subtotal: 365.

In the October 2023 release of Dynamics GP this same notification will look like this:

You have been assigned a task for the Sep 1 step in the Sales Transaction workflow for Order ORDST2233.

Task Deadline: 9/15/2023 4:50:00 PM
Edit or wview the document:

E-mail actions for workflow are not enabled.

Type: Order
Document
Customer:
Document
Document
Subtotal:

Notice how the Document Amount and Subtotal values are only displaying two decimals.

You will notice a similar change in the following assignment email for a Purchase Requisition in both the
document header and line information:
[You have been assigned a task for the Step 1 step in the Purchase Bequisition Approval workflow for Purchase Regquisition BEQ

Task Deadline: 9/15/2023 1:46:00 FM
Edit or wiew the document:

Company: Fabrikam, Inc.

Document Type: Purchase Requis
Requizition Number: REQ
Requested By: sa

Required Date: 4/12
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You have been assigned a task for the Step 1 step

Task Deadline: 9/15/2023 1:50:00 EM
Edit or view the doc g

E-mail actions for workflow are not enabled.

Company: Fabrikam, Inc.

Document Type: Purchase Reguisiti
Requisition Number: REQOO0OC
Requested By: sa

Required Date: 4/1

Document Date:

This change applies to the following workflow types:
Sales Transaction Approval

Purchase Order Approval

Purchase Requisition Approval

Receiving Transaction Approval

Table Physical Names

POP10100WF New company view
POP10110WF New company view
POP10200WF New company view
POP10210WF New company view
POP10300WF New company view
POP10310WF New company view
POP10500WF New company view
SOP10100WF New company view
SOP10103WF New company view
SOP10200WF New company view
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Project Time & Expense Workflow My
Expenses/ Delegates List

We have added 2 new Navigation Lists for Project Time & Expense specific to Expenses that are designed
to help you filter down the clutter and focus on Expenses that involve you and your team if you are a

manager or are set up as a delegate for others. These new lists are labeled as My Expenses and My Team
Expenses.

My Expenses list — Displays your Expenses, any Expenses submitted by you on behalf of others, and any
Expenses that are Pending your approval.

My Team Expenses list — Displays your Expenses, Expenses submitted by users that you are a delegate for
(your team), and any expenses that are pending your approval.

Power Users can also add the Workflow user Column to these navigation Lists to make it easier for users
to know whether they are the pending approver, or if the Expense is pending someone else's approval.

Select the Customize option under the My Team Expenses Drop Down List.

T My Team Expenses -

Save Ctrl+5

Save As... Ctrl+5Shift+5 r
Rename Ctrl+Y
Delete

Show/Hide 3

Add to Mavigation Pane as Shortcut
Add to Home Page

Rermove Personalizations

Refresh Ctrl+R

Click Columns and Mark Workflow User under Column Details.

Columns Details

Modify the content, layout and sharing settings for this view. Display Columns in this order
)
Wiew Name: My Team Expenses E Expense Report 1D
Visible In Al companies [¥] Document Date Move Down
Mark Content to Display ] status
[¥] Purpose
Show the filter options. 7] Total Cost
Show the action pane. [7] Empleyee D Beset
Show the information pane. 1 Employee Name
O
[7] Currency ID
Modify List View [T rReimbursable Amount

[T Task Due Date

[¥] Workflow USErI

®

Columns

Action Pane

+ ]

Sharing

(7} Preview Save Cancel
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You will now see the Workflow User column with the User that the Expense is Pending Approval by.

T My Team Expenses -
Show results

&0 Where v Status ¥ is ¥ Pending User Action -

sF Add Filter ~

[T Expense Report ID 4 Document Date  Status Purpose Total Cost Workflow User

[] ACKEO00O1-EE-D41227-2 4012/2027 Pending User A... Submitted by Employee $200.004 CONTOSOGP\USER1
[] ACKEDDO1-EE-D41227-3 412/2027 Pending User A... by Manager for Employee $300.004 CONTOSOGP\USER1
[[] BARROOO1-EE-041227-2 471242027 Pending User A... submitted by Manager for themselves $500.004 CONTOSOGP\USER2
[ DOYLODO1-EE-041227-2 401212027 Pending User A... submitted by other user $700.004 CONTOSOGP\USER1

NOTE: This process can be repeated for the My Expenses List and the My Timesheets List as well.

Project Time Expense Workflow my
Timesheets List

We have added a new Navigation List for Project Time & Expense specific to Timesheets that is designed
to help you filter down the clutter and focus on Timesheets that involve you. This new list is labelled My
Timesheets.

My Timesheets list — Displays your Timesheets, any Timesheets submitted by you on behalf of others, and
any Timesheets that are Pending your approval.

Microsoft Dynamics GP - 90301016.mac

gu' \'»,T Home » Project » PTE Timesheets » My Timesheets

Transactions ~ Inquiry ~ Reports ~ Cards ~

Microsoft Dynamics GP ~

Project _ ‘r b o JEH TLast0Days~ a
PTE Timeshests - A | == )| F Include Historic Transacti..>

Not Submitted ¥ ﬁ'?::’ T Include All Timesheets ¥ Sepocs

_Etndmg APP’i~ Workflow Modify Restrictions
PTE Expenses s l [T TimesheetiD « Document Date  Status Start Date End Date Total
Report List [ ATKI0001-TS-042314-1 04/24/2014 Pending User A... 04/23/2014 04/29/2014 42,00
Microsoft Dynam... | [] ATKIOOOI-TS-042314-2  04/24/2014 Pending User A... 04/23/2014 04/29/2014 21.00
SmartList Favorites | ™) ATKI0001-TS-042314-3 04/24/2014 Pending User A... 04/23/2014 04/29/2014 42.00
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Payroll Year-End Wage Report Formatting

Honestly, | can't believe we have lived with this report so long with no formatting!

A very common report we all use at payroll year end time is the year end wage report.

On this report by default the commas display in the header, but are not used in the body of the report.
Would make it more readable if wages, taxes etc. used the value definitions like commas.

With the 18.6 release, commas are added to numbers that display on the Year End Wage Report in Payroll.

From the Payroll Home page, under Routines, choose Payroll Year-End wage report.

Prior to 18.6

FICA Soc Sec Tax Rate:

FICA Soc Sec Wage Limit:
FICA Medicare Tax Rate:
EIC Maximum Withholding:

Ranges:
Reporting Year: 2027

Employee ID:

Sort by:

Beginning - End

MQGE / Employee ID

€.20000%
160,200.00
1.45000%

Employee ID: 13

13456789
abc
aneta, ND 592222

18.6 Release

12345678923456789234

Wages, Tips, Other Comp.:

40000000.00

Social Security Wages: 40000.00
Medicare Wages & Tips: 40000.00
Social Security Tips: 0.00
Advance EIC Payments: 0.00
Nonqualified Plans: 0.00

Federal Income

Social Security Tax Withheld:

Medicare Tax Withheld:

Allocated Tips:
Dependent Care

Employee ID: TERRY

JULIE
ABC

BNETA, ND 58212

Employee S8N: 49g-€5-9885

JOHNSON

Employment Type: Regular non-MOGE

Department: ACCT

W-2 Check Boxes:
Statutory Employee

Number of Employees:
Wages, Tips, Other Comp:
Social Security Wages:
Medicare Wages & Tips:
Social Security Tips:
Advance EIC Paymsnt:
Nongualified Plans:

Special Items Box:

stats Wages
i 219, 368.89
IN 40,279.03
WI 18,114.84
NE 40,991.74
MT 18,758.50
In 17,778.80
MM 23,316.92
Mo 16,364.68

Hetirement Plan

11,382,607.
SE7,130.
606, 530.

0.
0.
0.

s,518.
1,315.
1,000.
1,€65.
£87.
752.
925
448.
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Wages, Tips,Other Comp.:
Social Security Wages:
Medicare Wages & Tips:

Social Security Tips:
Advance EIC Payments:
Nonqualified Plans:

0.00 Rllocated Tips:

10,987,634.55 Federal Income Tax Withheld:
1€0,200.00 Social Security Tax Withheld:
200,000.00 Medicare Tax Withheld:

0.00 Dependent Care Benefits:

0.00

Federal Income Tax Withheld:
Social Security Tax Withheld:
Medicare Tax Withheld:

Allocated Tips:

Dependsnt Care Benefits:

Other Items Box:
401K

Locality

Wages

44,
25,
5

Tax Withheld: 12000087.

2480.

580.

0.

Benefits: 0.
0.0l
5.00
10.00
0.00
0.00

66
00
0o
00
00

391.45
234 .72
510.50

0.00

5%8.01

Looks really nice for the

bottom totals too.
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Letter Writing Assistant Expiring Test in
Human Resources

Test tracking in Human Resources has been very useful to customers for tracking a variety of test
information for their business. A nice way to notify employees about the test information is through the
Letter Writing Assistant.

Typically, customers like to use this mail merge reporting option as a way to notify of Expiration and test

due dates.

From the Employee Maintenance window, you can choose to Write Letters and prepare a new letter or
modify an existing letter.

il Employee N =
el vt @7
=22 " @
Save Clear Write Go File Print  Tools Help Add
Letters™ v ¥  Note
Acflons Go File = Help
kgt | ACKEQOO1 LB @ ClassiD | SUPP 2 O inactive
£ ezt Letter Writing Assistant 5]
Fﬂ’~ File Edit Tools Help sa Fabrikam, Inc. 4/12/2027
Middle s
Sulfix Prepare an Employee Skills and Tests Letter -
o Use this window to determine which employee skills and tests ta include in the letter. &
Seniori
. Select the type of skills and tests to includ F
Hire Di L
Adjuste O Skills All Skills and Tests |~ | Frlgr:
Last D_. [ Tests Al Skills and Tests
" | Expitation Date F
22 Skills Obtained | T
. Dr tilsts will be used for
Rezl ?I;:I:[f!;zuned iIl¥and Tests Letter. If at &
Secon e cfldes isn't assignedtoan | p
| SUTA yee will not be E s
422027
Pilar Ackerman
987 Willow Ave

Winnetka, IL 98272

Diear Filar,
Qur records indicate that your folowing kills and tests have approaching expiration dates.

Skill Set Skill Skill Obtained | Expiration Date | Skill Required
(Office Excel &g [T ieg
Offica Poweipainl s 402 e
Office: Word K 000 Y3
Test Code Description TestDate | Test Score | Expiration Date
OFFICE Office T 12312026
A A ERTP [
Sincerely,
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Letter Writing Assistant Final Notice
Collection Letter

Many customers like to use the Letter Writing Assistant reports for first, second and third notifications.
What we have seen is many of the customers modify the letters and add the Invoice detail information to
notify the customer of this information.

With the final notice collection letter, the system did not allow you to print the notice and add invoice
details.

With the release of 18.6, you can now modify any of the Collection Letter notices (1, 2 or 3/final) and add
the Invoice details to the report and it will print the information for the customer.

Fabrikam, Inc.
4277 West Oak Parkway
Chicago, IL 60601-4277

(312) 436-2671 Ext. 0000

Letter Writing Assistant 4122027
File Edit Tools Help sa Fabrikem, Inc. 4/12/2027 | Adam Park Resort
Roberta Masouras
P.O. Box 1391
Letter Templates Indianapolis, IN 46206-1391

Use this window to select the template pou would like to use.

Dear Roberta Masouras,

Please contact us immediately regarding your outstanding invoice(s)

Document # Date Terms Due Date Amount Due
First Motice SLS13014 1/23/2024 Net30 2/22/2024 $8.500.00
Second Motice SLS13015 1/29/2024 Net 30 2/28/2024 $5.445.19
SLS3004 11/23/2023 Net 30 12/23/2023 $2.391.34

Your account will be turned over to a collection agency if payment arrangements are not
made within seven days. This will have a negative effect on your credit rating.

Please send your payment in full or call us to make payment arrangements. We will be
required to take further action 1f you do not contact us regarding your account.

Sincerely,

TWO Inc.
HR

| < Back Cancel t (000) 000-0000 Ext. 0000
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System & Workflow

® The time to complete this lesson, including exercises, is 30 minutes.

@ After this lesson you will be able to:

e Setup Shared Mailbox with Modern Authentication

Completely Delete Document Attachments

This new feature in the Dynamics GP October 2023 release will allow you greater control over documents
you've attached to records in Dynamics GP. Previously, when you deleted an attachment, it was still
maintained in the database and moved to the Deleted tab in the Document Attachment Management
window.

With the Microsoft Dynamics GP 18.6 release, you have the ability to completely remove attachments
from Dynamics GP. To enable this functionality, you need to navigate to Microsoft Dynamics GP > Tools
> Setup > Company > Document Attachment Setup. Once there you need to mark "Allow attachments to

be deleted."

m Document Attachment Setup - TWO23 (sa) - X

O X @]
0K Cancel File  Tools Help | Add
= ¥ | Note

Actions File = Help

'[z Allowe D ocument Attachments

Attachmert Location Options
Default Location: &
] Delete file from Defauk Location alter attachment

Masiimurn File Size 99999 | 999 99 Megabyte Maximum

Attachment Management Defaults
[ llome sttachments to be deleted Athibute Detaults:
Delete Password

[ llows attachments to be added in inquiry windows

Inquiry Password

O|0|0|0|@®

Allow attachments to flow from Master Recods to Documents:
] Allow attschments to flow from Customer Mairtenance window

Type: O Flow @ Not Flow
EA Alow attachments to flow from Item Maintenance window

Type: O Flow (®) Mot Flow
] Allow attachments to flow from Vendor Maintenance window

Type: O Flow @ Not Flow
Allow altachments to flow from PTE Employee Expense Entry window
Type: Flow Mot Flow

Send Attachments in emall
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When you want to delete an attachment the user's process would then be:

1) Pull up the Document Attachment Management window that contains the attachment you want to
delete

2) Highlight the line for the attachment you want to delete

3) Click the Delete “H button. This will move the attachment to the Deleted tab on this window. If you
specified a password on the deletion process this is where you will be challenged for that.

4) When you switch to the Deleted tab on this window you will see that a new button, Delete, is added to
the Action Pane. When you click on that it will completely remove the attachment.

m Document Attachment Management - TW023 (sa) - x

| o i 9

QK File Tools | Help

Actions | File - Help
Record Type: Customer Card
Record Number: AAROMNFIT OO0
File Attachmeris:
Acive  |Delsted | -

| | D |File Mame Date * Time User Orign

i @
Description = (h
. Customer [nvaice (0T, oxps 41272027 21540PM sa CC FAE )

L}

T
m Document Attachment Management - TW023 (sa) - x
X0 w '@
Delete 0K File | Tools | Help
b -
Actions File z Help
Record Type: Customer Card
Aecord Number: AAROMFITOOO0
File Attachmeris:
Aclive  Deleted
|| D | FieMame Date = Time User ogn | E| &
Description @
. 4N 2/2027 21540 | za CC FaE
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Shared Mailbox with Multi-Factor
Authentication(MFA)

One of the exciting new features in the Dynamics GP October 2023 release is another request that comes
directly from customer feedback. You are now able to set up the Sales and Purchasing series to use a
shared mailbox for sending email.

With all the work we have done around Modern Authentication (MFA) and customers using it heavily,
Shared Mailbox was something customers found they needed.

The initial setup for this occurs in the Sales E-mail Setup (Microsoft Dynamics GP > Tools > Setup > Sales
> E-mail Settings) and Purchasing E-mail Setup (Microsoft Dynamics GP > Tools > Setup > Purchasing >
E-mail Settings) windows.

In these windows you will see a new checkbox, Use Shared Mailbox. When you mark that the "Have
Replies Sent to:" field will clear and change to "Shared Mailbox:".

You can enter the e-mail address you want documents e-mailed from that series (Sales or Purchasing) to
both appear to be e-mailed from and have replies sent back to,

P Purchasing E-mail Setup - TW184 (sa) - O *

Cancel File Tools | Help Add

T A T  Note
Actions File Tools Help
Purchasing Document Setup
Enable teszage (D
Purchaze Order PURCHASING P
Yendor Remittance REMITTANCE p

Shared Mailbox:
Select Names gpemail@igp. anmicrozaft. com

Allaw Changing ‘Reply o' address at Exty
Allow Update of E-mail at Entry
Use Shared Mailbox Wendor Setup
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I sales E-mail Setup - TW124 (sa)

O X

0K Cancel File Tools

- -
Actions File Tools

Sales Document Setup
Enable

O

Sales Quate

Sales Order

Sales Fulfilment Order
Sales [nvaoice

Sales Fetumn

Sales Back Order
Packing Slip
Receivables Invoice
Receivables Retum
Receivables Debit Memao
Receivables Credit tMemo
Receivables Finance Charge

Receivables Service/Repairs

[E > Jo

Help Add
¥ MNote

Help

Meszage 1D

SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT
SALES DOCUMENT

SALES DOCUMENT
SALES DOCUMENT

Receivables ‘W arranty

Custorner Statement

O EEREELR]EE]EE]E]E]E]ELE]

Cazh Receipt
Shared Mailbos:

|: Select Names

Allow Changing ‘Reply to' Address at Entry

Allow Update of E-mail at Entry
Usge Shared Mailbox

gpemailiE@gp. anmicrosaft, con

Customer Setup

K= K= K T ) R i ) K K R R

Microsoft Dynamics GP 18.6

After that, you will also need to add an additional APl permission to the App Registration in Azure

1) Log into the Azure Portal (portal.azure.com)

2) Navigation to App Registrations

3) Open the App Registration that you're using for Modern Authentication in Dynamics GP

4) Click on the API permissions setting on the left

5) Click on Add a permissions

6) In the window pane that opens click Microsoft Graph
7) Select Delegated permissions

8) In the search box type Mail.Send

9) In the items that are returned you should already have "Mail.Send" marked. You will need to mark

"Mail.Send.Shared" for the new feature

Microsoft Proprietary and Confidential Information
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Request APl permissions X

CAll APIS
—, Microsoft Graph
is' https://graph.microsoft.com/ Docs =

What type of permissions does your application require?

Delegated permissions Application permissions

Your application needs to access the API as the signed-in user. Your application runs as a background service or daemon without a
signed-in user.

Select permissions expand all
|;’-7 mail.send| *
*

o The "Admin consent required” column shows the default value for an organization. However, user consent can be customized per
permission, user, or app. This column may not reflect the value in your organization, or in organizations where this app will be used. Leam
more

Permission Admin consent required
v Mail (2)

Mail.Send &
Send mail as 2 user

No

Mail.Send.Shared (&
Send mail on behalf of others

No

10) Click the Add permissions button
11) To finalize this, click the "Grant admin consent for %domain%" button on the APl permissions window.

All permissions in the list should have a green checkmark in the Status column when this is completed.

B Overview

&

Quickstart
@ The “Admin consent required” column shows the default value for an organization. However, user consent can be customized per permission, ser, or app. This calumn may not reflect the v
;.' Integration assistant

Manage Configured permissions

Applications are authorized to call APIs when they are granted permissions by users/admins as part of the conzent process, The list of configured permissions should include
all the permissions the application needs. Learn more about permissions and consent

EE eranding & properties

2

Authentication

Add a perm\sslol ~ Grant admin consent for Mlcrosnl
Certificates & secrets

API / Permissions name Type Description Admin consent requ... Status
Il Token configuration / P P q
S API permissions ~ Microsoft Graph (8) ban
@ Expose an API Mail.Read.Shared Delegated  Read user and shared mail No @ Granted for Microsoft e
App roles Mail ReadWrite Delegated  Read and write access to user mail No @ Granted for Microsoft e

24 Owners Mail.Send Delegated  Send mail as a user No @ Granted for Microsoft L)
&, Roles and administrators Mail.Send.Shared Delegated  Send mail on behalf of athers No @ Granted for Microsoft e
Ml Manifest offline_access Delegated  Maintain access to data you have given it access to No @ Granted for Microsoft e

openid Delegated  Sign users in No @ Granted for Microsoft L)
Support + Troubleshoaoting

profile Delegated  View users' basic profile No @ Granted for Microsoft s
ﬂ Troubleshooting

User.Read Delegated  Sign in and read user profile No @ Granted for Microsoft e

:‘.‘ New support request
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In terms of a user's experience with this feature, when they first attempt to perform an e-mail action in
their Dynamics GP session they will be presented with the same sign-in window that they always see when
using Modern Authentication. They would log in as their own account there. When they email the Sales
or Purchasing document it will send as the account specified in the Shared Mailbox field.

It is important to note that the account you use to sign into email needs to be able to send on
(D behalf of the Shared Mailbox account. This delegation is something that needs to be setup in
Exchange by an appropriate administrator.

If there is a problem with this setup you will get the following when you attempt to e-mail:

Send Document Errors

The following errars were found while attempting to send the document in -mail:

There were one ar more issues when processing emaill, please review the ~
DipnamiczGP_MS GraphEmail log file in the temp directory

W

Cloze

You can go to Start > Run, type %temp% and click OK to open the temp directory. When you look at the

DynamicsGP_MSGraphEmail.log file you will see something like the following:
9/6/2023 4:13:43 PM: <MSGraphEmailSendEmail>d__35.MoveNext - Code: ErrorSendAsDenied

Message: The user account which was used to submit this request does not have the right to send mail on
behalf of the specified sending account., Cannot submit message.

ClientRequestld: Oacbbd6f-8b50-4b53-8fcd-cbaede87eac3

This error explains they the user is not setup to email on behalf of the shared mailbox account and
adjustments need to be made in Exchange/Microsoft 365.

Table Changes
Table Physical Names Table Technical Name New Field
SY04902 syEmailSeriesSetup EmailUseSharedMailbox
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Microsoft Dynamics GP 18.6

Modern Authentication - Single Tenant App
Registration

The Microsoft Dynamics GP October 2023 release now allows you to create an App Registration in Azure
that uses the Single tenant option in addition to the multi-tenant option we previously required.

There are more security-minded customers that require the multi-tenant authentication option in the
Azure App Registration. Prior to 18.6 release, if you select the single-tenant option, the Modern Auth

window in Dynamics GP will give "Unknown error".

The main difference between Single and Multi-tenant is what the authentication URL looks like, If it
contains /common it is going to use multi-tenant. In order to use single tenant, it has to also include the

Tenant ID.

This option in the app registration is something you can pick when you're first setting it up, or

alternatively in the Authentication settings page in an existing app registration:

Manage

=

©)

Supported account types

Branding & properties

Authentication

Certificates & secrets

Who can use this application or access this API?

Token canfiguration

Help me decide...

'@] Accounts in this organizational directory only (Microsoft only - Single tenant)

O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant)

To accommodate this ability a new field, Tenant ID (Optional), has been added to the Company E-mail
Setup (Microsoft Dynamics GP > Tools > Setup > Company > E-mail Settings) window:

m Company E-mail Setup - TW124 (sa)

O X il

k.

)]

OK  Cancel File Tools | Help Add

Mote

Actions File Tools Help

>

Select E-mail Document Options

Embed Documents in Message Body
Send Documents as Attachments

File Formats Allowed

DOCx HTHML FDF

Enable E-mail
Sales Senes

Purchasing Series

HPS

Desktop and “w'eb Client Properties
Tenant ID [Optional]

Application [Client] 1D | |

‘web Client Properties
Application [Client] 1D

Key
Fedirect URL
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The value for this field comes from the Overview page of your App Registration in the Azure Portal. The
specific field is called "Directory (tenant) ID". Copy that value into the Tenant ID field in Company E-mail
Setup, along with the Application (client) ID, to enable Modern Authentication e-mail in Dynamics GP.

Table Changes

Microsoft Dynamics GP 18.6

Table Physical Names

Table Technical Name

New Field

SY04900

syEmailSetupOptions

MSGraphTenantID

Summary of all Table Changes in 18.6

Company Table Changes

Table Physical Names

Table Name

New field

SY04900 syEmailSetupOptions MSGraphTenantID
POP40100 POP Setup UMDEFAULT
SY04902 syEmailSeriesSetup EmailUseSharedMailbox
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